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Welcome to

Alpha Five Made Easy
The Basics and More for Version 8

by Susan Hussey Bush

Chapter 5 - Reports, Letters & Labels
Sample Chapter (Partial)

About the book and Alpha Five…
Alpha Five Made Easy is a step-by-step manual for learning the Alpha Five database software and is

intended to be used with the companion databases provided with purchase of the book. It contains
almost 475 pages of step-by-step exercises with screen shots. This sample will give you a peek at the
material contained in the book.

The full chapter on Reports, Letters and Labels is actually 62 pages long. We have included its Table
of Contents so you can judge for yourself the depth of the material.

Users of all levels will find this book is the quickest way to tap into the fabulous Alpha Five features.

For more information and to purchase the book, go to 
www.libertymanuals.com.

Frances M. Peake, professional database designer and co-owner of Proctor & Peake, Inc., enthusi-
astically endorses Alpha Five Made Easy and answers a question about Alpha Five.

“The plain-English explanations of each Alpha Five feature in this
book show Susan's experience applying the program in a real-world
business environment. Readers will find every chapter full of valu-
able information, regardless of their experience level. On behalf of
Alpha Five users and enthusiasts everywhere, thank you Susan, for
writing this book!”

“With regards to Alpha Five, we are long time Q&A users and have been looking for a replacement
that is easier than Access©, dBase©, etc., but has the power to write strong applications without a lot of
coding. Is Alpha Five the product we are looking for? I would appreciate your opinion.” — RADeV, Jr.

“You indicate that you are looking for “the power to write strong applications without a lot of cod-
ing.” In that case, yes, Alpha Five is a better choice than Access. I develop applications in both and I
tell you that you can go so much farther in Alpha Five without having to do programming. In fact, you
may not have to do any coding at all. Alpha Five offers a lot of commands and properties that simply do
not exist in Access, where you would have to write your own procedures and functions to do the same
thing.

“Even when you need to automate a process, Alpha Five has a number of alternatives to writing
code, such as “Action Scripting” that lets you perform the steps you want to automate and generates the
code for you. There are, of course, some things that you might dream up that will require writing code in
Alpha Five.” 

—FMP
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About the author

 From her first computer experi-
ence in 1984 - a used Apple I presented by
her father after he upgraded to an Apple II -
Susan Hussey Bush has been hooked on this
amazing (and sometimes frustrating) tool of
the modern world. The 1985 purchase of the
state of the art IBM XT with an astounding 10
mg hard drive opened the door to database
development. That first flat database, Nut-
shell, showed her that one did not have to be a
programmer to develop applications. Later,
she began the search for a relational database
that did not require programming skills.
Alpha Four, a DOS product, met those
requirements. When Alpha Five was released,
she moved to the Windows version. After
expending considerable effort learning the
program and designing on her laptop, it was
stolen. The only copy of the database was
gone and a serious setback resulted. The good
news is that by the time she started over,

Alpha Five version 3, with significant
improvements over the earlier versions, had
been released.

The development of a database for her gov-
ernment bidding company, Liberty Food Mar-
keters Co., then began in earnest - this time
with backups! Today, that application con-
tains more than 60 tables and 75 sets. As a
non-programmer, Susan has set up 100 saved
operations to import, reformat and export
data. She has since sold the business to her
son, Dave, who continues to use Alpha Five
to stay current with the demands of govern-
ment bidding and to offer customers outstand-
ing service.

Susan has a Bachelor of Fine Arts in Archi-
tectural Design. She brings that training to her
database design, focusing on well organized,
attractive forms and reports. Alpha Five
allows her to create database applications
reflecting her belief that software should be
user-friendly. She is excited about adding Ver-
sion 8 features to her databases.

Presently living in Flat Rock, North Caro-
lina, she travels extensively with her husband,
Richard Bush. There are seven children and
eight grandchildren in their blended family,
spread across the country. Mike, Liz and
Walter Hussey live in the Florida Keys. JR
Hussey and his wife, Carin Young, live in San
Francisco. In Rumson, New Jersey, Susan’s
hometown, Dave Hussey keeps busy with
Liberty Food Marketers Co. Rick Bush’s
daughters, Taylor, Jordan and Lindsey live in
Pea Ridge, Arkansas. He and his oldest
daughter, Hailey, live in Neosho, MO, where
Richard grew up. Ross and Mariola Bush live
in Rolla, Missouri where Mariola recently
graduated as a Civil Engineer and Ross is
studying the law. Residing in Fort Smith,
Arkansas are Missy, her husband, Jeff Brown
and son Jake. Kathleen and Sands Orris and
their sons, William and Foster make their
home in Cumming, Georgia.
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fore its page numbers and/or content may not be identical to that in the actual book.

Products
We offer several combinations of hard copy and electronic versions of our books. For more informa-

tion and pricing, visit www.LibertyManuals.com.
•Alpha Five Made Easy

•Electronic download version. Full color, may be printed. No index. 
•Hard copy of book. Full color, with index. Spiral bound.
•Electronic Book on CD. Full color, with index.
•V8 Combo Pack. Hard copy of Book and Book on CD.
•V8 Combo with Alpha Five Functions Handbook.

•Alpha Five Functions Handbook
•Hard copy of Book. Spiral bound.
•Book on CD.
•Combo Pack: Book and Book on CD.

Money Back Policy
•Satisfaction 100% guaranteed. Notify us within 30 days for a full refund on all products 
except the download version of the book.



 Chapter 5.

Reports, Letters and Labels

Alpha Five has awesome reporting capabilities.

The power of a database is the multitude of ways the data can be viewed. The same informa-
tion that confirms a sale can show a complete report of purchases by all customers.
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Preparation for the Lesson.
Open Alpha Five and navigate to the following file:

•c:\A5_Ver8Book\ABC_V8_Lessons\ABC Seminars.adb*

•  Click on the Control Panel tab in the Window Bar at the bot-
tom of the screen to bring the Control Panel to the front.

SPECIAL NOTES As fields are added to the form, the Summary Genie may pop–up. Accept the default
settings and click Finish.

These techniques my be applied to any report. To do so, open the report in design
mode to begin the segment.

These exercises are designed to be done in book sequence. If you do the Operations
section before this Reports section, the report may not match the steps in the book
because, when removing duplicate names, some client names may have been deleted.
To work around this problem, reinstall the data from the companion disk. It will over-
write any changes you have made.

Because this is a long chapter, it has been broken into a series of exercises. The quill
and inkwell mark the beginning and end of each exercise.

LOOKING AHEAD!† The following reports may be previewed at the Alpha Five Control Panel Reports
tab. There are also buttons for some of the reports on the Clients form.

•Quick Report: MyFirstReportDemo
•Custom Reports:

•Registrations
•Receipt: To Print Preview, enter any ID from 00001 – 00007. (Button on 

ClientInfo form)
•Schedule: To Print Preview, enter 00001

•Sub-Report: MyRegistrationsGenieDemo
•Letters: Confirmation Letter

Learning Report basics

Alpha Five presents a quick and easy way to get started with reports. We will first
design a report using the genie and then will update the report with some custom design.

FINISHED REPORT Open the RegistrationsGenieDemo report to see a completed report for this seg-
ment.

Quick Reports mean a quick start
First, we will make a Quick Report.

*. Depending on how Alpha Five is opened, the file extension .adb may not appear. (For instructions on opening an existing database, 
see “Opening an existing database” on page xxxvi.)

†. For experienced or returning users. May be helpful to beginners who want to see the results of the exercise.
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1. Alpha Five Control Panel Tab: Reports.
2. Click the New button.
3. Data Source: registration_rept.set
4. Method: Choose Use Quick Report. (Click OK)

•The Quick Report definition dialog box opens.

5. Set the following parameters:
•Title: Registrations.
•Style: Groups with totals.

6. Click the Fields button (should be default).
7. Select fields: Table: Choose Registration. Double click or drag the fol-

lowing fields to add them to the Fields box on the right side:
•Registration ID.
•Seminar ID.
•Registration Date.
•Paid Date.
•No Persons.
•Rate.
•Amt Pd.

HINT! To remove a field from the Fields box, drag it off to the right, out of the box. It
should be removed from the list.

8. Table: Choose Clients. Double click the following field to add it to the
Fields box:
•Last Name.

REORDERING THE FIELDS • The fields appear on the report in the order listed in the Fields box. We will change 
the order of the fields so they will be more logical for this report.
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9. Fields: Click Seminar ID, drag it up to the top of the list.

HINT! If you have trouble getting the field to the top, move it to 2nd place. Then move the
top field below it—like a Rubix cube!

10. Drag Clients->Last Name to the 3rd position.
11. Click the Group button.

•The entry box on the right changes to Groups.

12. Double click Seminar ID to place it in the Groups box.
13. Click the Order button. 
14. Double Click Clients->Last Name to move it to the Sort fields box.
15. Click the Summary button.

•The genie has filled in the fields—all numeric—that are eligible for a sum-
mary operation.

16. Click the Options button.
17. Click the checkboxes as follows:

•Fields: Bold.
•Page: Page Number, Day/Date, Center Title.

18. Click OK.
•The Report Editor appears. We will explain in detail each of the sections, but 

first let’s make one quick change and then take a look at the report.

19. Right click on the large title in the report, Registrations.
20. Choose Properties.

•Properties are changed here in the same manner as on forms.

21. Tab: Font; Color: Red. (Click OK)
22. CTRL + S to save.

•Save as MyFirstReport. (Click OK)
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23. Print Preview the Report.
•Click the Preview button on the Reports Toolbar.
•Or choose File > Print Preview.

Understanding the Print Preview tabs
When you go to Print Preview from the Report Editor, an additional tab is opened in

the Window Bar below the report.
•If the tabs are not showing, choose View > Window Bar from the Top Menu 

to open that section of your screen.

These tabs allow you to move quickly between Print and Print Preview. There are
certain notations, however.

•If you change the report, and then click the Print Preview TAB, the change 
will not show.

•To show the change, click Exit Preview  on the Print Preview 

Toolbar and reclick the Print Preview  Button on the Report Editor Tool-
bar.

•If you did not save the report before clicking the Print Preview TAB, an aster-
isk will appear on to the Report Editor tab.*

•In order to save the report, you need to first click  Exit Preview 

on the Toolbar and then save the report. When you reopen  Print Pre-
view, the asterisk will be gone, indicating a saved and therefore current 
design.

Understanding the Print Preview Toolbar
The Print Preview Toolbar gives a wide range of options for saving the individual

reports. For example, many companies are requesting that invoices be E-mailed. You
can save the report in one of four formats common to most computer systems and E-
mail the report with the click of a single button.

VIEWING PAGES The first group of buttons are for viewing certain pages in the report.
•First page.

*. This asterisk appears only at Print Preview. Its purpose is to note that a certain part of the Print Preview view no longer accurately 
represents the entire report editor design. There may be other parts that you want to examine, however.
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•Previous page.
•Go to page <number> (Enter the number of the page to which you want to 

go.)
•Next page.
•Last page.

PRINTING THE REPORT The next group is for printing the report.
•Print.
•Print Setup.

VIEWING OPTIONS The next group gives options for viewing the report on screen.
•Zoom.

There are two zoom settings, in and out. 
You may also zoom by moving the cursor onto the report. It

changes to a magnifying glass. Click on the report to zoom in
or out.

•Two pages.
 Shows 2 pages on the screen at one time. Zoom must be set

to lesser magnification so there is room on the screen for both
pages.

•Color.
Toggles areas with color off/on.

24. Click Color.
•The red Registrations title is changed to black.

25. Click Color again.
•The Registrations title is set back to red.

RETURNING TO DESIGN 
MODE

The next button returns to Report Design Mode.

• Exit Preview

SAVING REPORTS AS PDF, 
HTML, RICH AND PLAIN 
TEXT FILES 

The next two buttons have multiple choices. The first forms the report in a different
format where it can then be saved from that program. The second forms the report in the
selected format and opens a Send Email form, with the report attached. The major
advantage is that reports can be viewed by users who do not have Alpha Five installed
on their computers.

In addition to these formats, reports may be saved and printed within Alpha Five
itself.

26. Click the drop down arrow adjacent to the button next to Exit Preview.
•When you hover over the down arrow, bubble help reads: Select format for 

saving report. 
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•There are 4 file types to which you can save and/or send the report.

NOTE Our purpose at this time is to give an overview of the features available. Instructions
for enhancing these formats is detailed in “Enhancing PDF, HTML & Rich Text report
formats” on page 205.

• The icon on the button is for the last format used.

• Adobe Acrobat PDF. Most users have Adobe Acrobat Reader on their 
computers. It is also available as a free download at www.adobe.com.

• Dynamic HTML File. Form will open in Microsoft Internet Explorer.

• Rich Text File. This can be read and edited by users of Microsoft Word 
and Corel WordPerfect.

• Plain Text File. Removes all formatting. Can be read by any computer.

SELECTION OVERVIEW • To use or change formats:
a. Click the current button or its drop down arrow.

b. Choose the desired format.
c. If you like, you can preview at the format options now, but we will exam-

ine them in detail at “Enhancing PDF, HTML & Rich Text report formats” on 
page 205.

•The report will be formed in the chosen format.
•That format will remain the default. In other words, if you format a report as 

a Rich Text file, the  icon will appear on the Toolbar.
•It can, of course, be changed to a different format at any time.

NOTE If you do not save the report prior to going to Print Preview, you will get an error
message advising you to return to design mode and save the record.

27. Choose Adobe Acrobat PDF File.*
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28. File name: Accept the default.
• C:\A5_Ver8Book\ABC_V8_Lessons\MyFirstReport.pdf

29. Open file with associated application? Check (Yes)
30. Click OK.

•The program may ask for permission to overwrite an existing field. (Yes)
•If it is unable to find a PDF driver, Alpha Five will ask for permission to try 

to install it. (Yes)
•If the PDF driver is installed correctly, the report appears on the screen. 

31. Close Acrobat. 

SENDING EMAIL 
ATTACHMENTS*

The process for sending email attachments is essentially the same as above.
a. Click the current button or its drop down arrow.
b. Choose the desired format from the Send As dialog.

A third step is necessary, though. In order to actually send an email, you will need to
tell Alpha Five which email client to use. For the purposes of this exercise, we will
choose Default e-mail client to use your existing e-mail client, such as Outlook or Out-
look Express. E-mailing with Alpha Five is discussed in Chapter 11 beginning on page
335.

32. Click the Send a report via email button.
33. Choose Adobe Acrobat PDF File format.

34. Click the Options button.

35. Choose Default e-mail client. (Click OK)

*. This choice requires that Adobe Acrobat Reader be installed on your computer. You may get a free download at www.adobe.com. 
You may also choose another format if you prefer.

*. If your computer is new and/or you have not set up an email account, you may be directed to go to the “Mail Icon on the Control 
Panel.” This means the WINDOWS CONTROL PANEL, not the Alpha Five Control Panel. Open the Windows Control Panel and 
click on Mail to set up the account.
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36.  Click OK and then Click Send.
•The report is formed and the send email window opens with the report 

attached.

37. Close the email window—or send yourself a test email! And while
you’re at it, send me a copy! I’ll be sure to email you back a congratula-
tory note for getting this far!*

MORE WAYS TO CLASS UP 
YOUR REPORTS

• Note that these file types support color as well as black and white type. That means 
you can put your color logo on a report and email it to your customer. 

• You can also post these files on your web site for viewing. The PDF format works 
very well for this. Just put the link on your web page and store the actual file on the 
server.

ALPHA FIVE CONTROL PANEL The final button on the toolbar takes you to the Alpha Five Control Panel.

38. If possible, print a copy of the report, now. You will find the
print–out handy to use as a reference for the following exercises.
•Click the Print button on the Reports Toolbar.
•Or choose File > Print or CTRL + P.

39. Click Exit Preview. 
•You are returned to Design mode.

If, for any reason, you are no longer in Design mode, do the following:
•Alpha Five Control Panel Tab: Reports
•Right click > Design: MyFirstReport (or RegistrationsGenie).

40. Maximize the Report Editor to make it as large as possible on the
screen.

*. My email address is susan@LibertyManuals.com.
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PLEASE TAKE A MOMENT TO 
READ THIS

Understanding the Report Editor*

• Toolbox: The Report Editor Toolbox contains fewer tools than that of the Form Edi-
tor Toolbox, however, the use for each tool is the same. The Sub-Form button is 
replaced with the Sub–Report control

•If you cannot see the full report editor, we recommend you make the Toolbox 
and DragDrop List as narrow as possible.

• DragDrop List: Same for both the Report and Form Editors.†

•  Report Toolbar: Same as the Forms Toolbar,‡ plus one new button, Select 

Records. 

• Reports Top Menu: differs from the Forms Top Menu** as follows:
•View: There are 3 new options that toggle on/off various elements of the 

report. (See “Viewing Sections” on page 167.)
•Report:

a. Select Records. Applies filters. (See “Filtering and Ordering Reports” on 
page 195.)

b. Properties. 
•Band

•Report Properties, p. 193.
•Detail Properties. p. 195.
•Group Properties. p. 198.
•Region Properties. p. 200

•Region 
See “Understanding Region Properties” on page 200.

•Body for Report Header

*. This segment covers the basic elements of reports. For more information on the features available in reports, see A5 Help > User 
Guide > Reports.

†. See “Using the DragDrop List” on page 74.
‡. See “Understanding the Forms Toolbar” on page 61.
**.See “Understanding the Top Menu” on page 58.
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Alpha Five’s Functions allow the development of data-

base applications without programming. In this handbook,

they are explained simply, in layman’s terms. This manual

was born of the author’s many years of frustration while

searching for the right function for the job. Character,

date, numeric, summary or filter—you’ll find and use

them easily in this logically designed manual.

Available at www.LibertyManuals.com or call 1-732-842-3000

Expand your Alpha Five applications with the 

Alpha Five Functions Handbook, Functions and

Expressions Made Easy.
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Learning the basics of Alpha Five and enhancing your applications. 

Learning the Web Application Server so you can go live on the web. 

Making the transition from Alpha Four to Alpha Five. 

Alpha Five Made Easy

The Basics and More for Version 8

This is the book you’ve been looking for—Everything you need to know to learn the most user-friendly 

database and web application programs and out there! If you are already familiar with Alpha Five, you will find 

many tips for a successful application. Learn the new Web Application Server and put your database on the 

web! Make the transition from Alpha Four to Alpha Five. Now is the time to GET INTO ALPHA FIVE!*

Frances M. Peake, professional database designer and co-owner of Proctor and Peake, Inc., enthusiastically endorses 

Alpha Five Made Easy and answers a question about Alpha Five. 

“The plain-English explanations of each Alpha Five feature in this book show Susan's ex-
perience applying the program in a real-world business environment. Readers will find 
every chapter full of valuable information, regardless of their experience level. On behalf of 
Alpha Five users and enthusiasts everywhere, thank you Susan, for writing this book!”

 “With regards to Alpha Five, we are long time Q&A users and have been looking for a replacement that is easier than Access, 

dBase, etc., but has the power to write strong applications without a lot of coding. Is Alpha Five the product we are looking for?  

I would appreciate your opinion.”                                                                                                                                         — RADeV, Jr. 

 “You indicate that you are looking for “the power to write strong applications without a lot of coding.” In that case, yes, Alpha 

Five is a better choice than Access. I develop applications in both and I tell you that you can go so much farther in Alpha Five without 

having to do programming. In fact, you may not have to do any coding at all. Alpha Five offers a lot of commands and properties that 

simply do not exist in Access, where you would have to write your own procedures and functions to do the same thing. 

  “Even when you need to automate a process, Alpha Five has a number of alternatives to writing code, such as  “Action Scripting”

that lets you perform the steps you want to automate and generates the code for you. There are, of course, some things that you might 

dream up that will require writing code in Alpha Five.”                                                                                     — FMP 

The equipment you will need to have to use this book: 

You will need to have the Alpha Five program installed on your 

computer. Information on purchasing the program may be found at 

www.alphasoftware.com.± 

Alpha Five Version 8 Professional and Enterprise editions contain 

full design features of the Web Application Server program, but 

require licensing to use it on the Internet or an Intranet. Call Alpha 

Software for details. 

A companion CD containing the working databases for the book is 

included with this manual. 

* GET INTO ALPHA FIVE! seminars have been pro-

duced by Frances M. Peake and Susan H. Bush. 

For more information, call 1-732-842-3000. 
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